IBM System z Hardware Management Console (HMC) 2.11.0
(including some 2.11.1 Updates)

August 9, 2011

SHARE in Orlando

Brian Valentine
HMC Development
bdvalent@us.ibm.com
File Updated: 08-03-11
Topics

► HMC System support

Page: 5

► HMC 2.11.1 Enhancements

- HMC/SE Secure FTP support
  Page: 6 – 9
- Disruptive Action Confirmation Enhancement
  Page: 10 – 13
- Load (IPL) for Alternate Subchannel set
  Page: 14 – 15
- View PMV (Problem Management Viewable) Records
  Page: 16 – 19
- 2048 bit Network Certificates
  Page: 20

► Application Enhancements

- New Task Group
  Page: 21
- Environmental Efficiency Statistics Task
  Page: 22 – 25
- SAD Re-Engineering
  Page: 26 – 29
- Security Event Notification
  Page: 30 – 31
- Offload Enhancements for Customer Audit
  Page: 32 – 40
- Change LPAR Controls – Export to CSV File
  Page: 41 – 43
- Change LPAR Controls Scheduled Operation
  Page: 44 – 45
- ETR Function Removal and Pulse per Second Diagnostic Support
  Page: 46 – 47
- HMC User ID Templates
  Page: 48 – 52
Topics (cont.)

► User Interface
  ● User Interface Enhancements Page: 53 – 55
  ● Classic UI and User Settings Task Improvements Page: 56 – 58
  ● Flexible Controls per User on SE Page: 59 – 60
  ● View Only User IDs/Access for HMC/SE Page: 61 – 62
  ● Additional Control over Toggle Lock and Details Tasks Page: 63 – 64

► Configuration and Service
  ● Third Sub-channel Set Page: 65
  ● Increased Number of Processors Page: 66
  ● Broadband RSF/Media Only Firmware Component Updates Page: 67

► Miscellaneous
  ● Allow setting Acceptable Status for Multiple Objects Page: 68 – 69
  ● New Removable Writeable Media to Replace HMC DVD-RAM Page: 70
  ● Power Saving Mode Page: 71 – 73
Topics (cont.)

► Additional Materials

- Additional Miscellaneous HMC 2.11.0 Enhancements
  - CFCC Diagnostics
  - 3-D Repair and Verify
  - Service User Task for RSF Diagnostics
  - Power on Reset Support of Automatic I/O Interface Reset
  - Consistent Sorting for Operating System Messages
  - Controlling Group Capacity with HMC SNMP API
  - Image Activation Profile Validation Override
  - Remove Support for Dynamic ICF Expansion Option
  - Remove Support for Crypto Express2

- Other SHARE Sessions of Related Interest
- Registering for IBM Resource Link Access
- Notable HMC/SE Publications
HMC System support

- The new HMC Version 2.11.1 will support the systems/SE (Support Element) versions shown in the table.

- The 2.11.1 HMC will support up to two 10/100/1000 Mb Ethernet LANs (1 Gb LAN support)
  - Optional HMC External Switch available as 1 Gb
  - Internal z196 switch for HMC to SE LAN connection has 1 Gb ports

<table>
<thead>
<tr>
<th>Machine Family</th>
<th>Machine Type</th>
<th>Firmware Driver</th>
<th>SE Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>z114</td>
<td>2818</td>
<td>93</td>
<td>2.11.1</td>
</tr>
<tr>
<td>z196</td>
<td>2817</td>
<td>86, 93</td>
<td>2.11.1, 2.11.0</td>
</tr>
<tr>
<td>z10 BC</td>
<td>2098</td>
<td>79</td>
<td>2.10.2</td>
</tr>
<tr>
<td>z10 EC</td>
<td>2097</td>
<td>79</td>
<td>2.10.2</td>
</tr>
<tr>
<td>z9 BC</td>
<td>2096</td>
<td>67</td>
<td>2.9.2</td>
</tr>
<tr>
<td>z9 EC</td>
<td>2094</td>
<td>67</td>
<td>2.9.2</td>
</tr>
<tr>
<td>z890</td>
<td>2086</td>
<td>55</td>
<td>1.8.2</td>
</tr>
<tr>
<td>z990</td>
<td>2084</td>
<td>55</td>
<td>1.8.2</td>
</tr>
<tr>
<td>z800</td>
<td>2066</td>
<td>3G</td>
<td>1.7.3</td>
</tr>
<tr>
<td>z900</td>
<td>2064</td>
<td>3G</td>
<td>1.7.3</td>
</tr>
<tr>
<td>9672 G6</td>
<td>9672/9674</td>
<td>26</td>
<td>1.6.2</td>
</tr>
<tr>
<td>9672 G5</td>
<td>9672/9674</td>
<td>26</td>
<td>1.6.2</td>
</tr>
</tbody>
</table>
HMC/SE Secure FTP support – 2.11.1

- New support was added to allow a secure FTP connection from a HMC/SE FTP client to a customer FTP server location
  - Implemented using the SSH File Transfer Protocol which is an extension of the Secure Shell protocol (SSH)
  - A new Manage SSH Keys console action allows the customer import public keys associated with a host address – added to both HMC and SE.
  - Secure FTP infrastructure allows HMC/SE applications to query if a public key is associated with a host address as well as to utilize the Secure FTP interface with the appropriate public key for a given host.
  - Tasks utilizing FTP now provide a selection for the Secure Host connection.
    - When selected they verify that a public key is associated with the specified host name, and if none is provided they put up a message box to point them to the Manage SSH Keys task to input one. Tasks that provide this support include:
      - Input/Output (I/O) Configuration -> Import/Export Source File -> FTP Location
      - Customize Scheduled Operations (Audit and Log Management only)
      - Retrieve Internal Code -> Retrieve code changes from FTP site to the selected objects
      - Change Console Internal Code -> Retrieve Internal Code Changes -> Retrieve code changes from FTP site to the HMC
      - Advanced Facilities->Card Specific Advanced Facilities->Manual Configuration Options-> Import/Export source file by FTP (For OSA-ICC PCHIDS only – Channel Type=OSC)
HMC/SE Secure FTP support (cont.)

- New Manage SSH Keys console action
HMC Secure FTP support (cont.)

- Export IOCDS Panel showing the new “Use secure FTP” checkbox
HMC Secure FTP support (cont.)

- Export IOCDS Panel showing message display if the new “Use secure FTP” checkbox is selected but no SSH keys exist for the specified address.

![Image showing a message box with a message about using secure FTP with no key defined for the entered IP address.](image-url)
Disruptive Action Confirmation Enhancement – 2.11.1

- The Operating System Name was added to the Disruptive Action Confirmation panel.

- Optionally, the Disruptive Action Confirmation panel requires additional text input before a disruptive action is allowed.
  - The required text is either the OS Name or System Name
  - This option is controlled via the User Profiles task on an individual user ID basis.
Disruptive Action Confirmation Enhancement (cont.)

- OS Name column was added

**Attention: The Deactivate task is disruptive.**

Executing the Deactivate task may adversely affect the objects listed below. Review the confirmation text for each object before continuing with the Deactivate task.

**Objects that will be affected by the Deactivate task**

<table>
<thead>
<tr>
<th>System Name</th>
<th>Type</th>
<th>OS Name</th>
<th>Status</th>
<th>Confirmation Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>GDLVMBUV:CECSIMVM</td>
<td>Image</td>
<td>GDLVMBUV</td>
<td>Operating</td>
<td>Deactivate causes operations to be disrupted, since the target is currently in use and operating normally.</td>
</tr>
<tr>
<td>GDLVMBUV.ZLINX</td>
<td>Image</td>
<td></td>
<td>Operating</td>
<td>Deactivate causes operations to be disrupted, since the target is currently in use and operating normally.</td>
</tr>
<tr>
<td>GDLVMBUV.ZVM53</td>
<td>Image</td>
<td>ZVMV5R30</td>
<td>Operating</td>
<td>Deactivate causes operations to be disrupted, since the target is currently in use and operating normally.</td>
</tr>
<tr>
<td>GDLVMBUV.ZVM54</td>
<td>Image</td>
<td>ZVMV5R40</td>
<td>Operating</td>
<td>Deactivate causes operations to be disrupted, since the target is currently in use and operating normally.</td>
</tr>
<tr>
<td>GDLVMBUV.ZVM81</td>
<td>Image</td>
<td>ZFWVMTS1</td>
<td>Operating</td>
<td>Deactivate causes operations to be disrupted, since the target is currently in use and operating normally.</td>
</tr>
</tbody>
</table>

Do you want to execute the Deactivate task?

Type the password below for user "SYSPROG" then click "Yes".

[Password input field]

[Yes] [No] [Help]
Disruptive Action Confirmation Enhancement (cont.)

- Confirmation Text Required - this is optional

---

**Attention: The Deactivate task is disruptive.**

Executing the Deactivate task may adversely affect the objects listed below. Review the confirmation text for each object before continuing with the Deactivate task.

**Objects that will be affected by the Deactivate task**

<table>
<thead>
<tr>
<th>System Name</th>
<th>Type</th>
<th>OS Name</th>
<th>Status</th>
<th>Confirmation Text</th>
<th>Confirmation Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>LP01</td>
<td>Image</td>
<td>Operating</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LP02</td>
<td>Image</td>
<td>Operating</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LP03</td>
<td>Image</td>
<td>Operating</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Type the OS Name, if available, otherwise the System Name as the confirmation text for the objects which still need to be confirmed, then click "Confirm". Otherwise click "Cancel" to cancel this task.
Disruptive Action Confirmation Enhancement (cont.)

- **User Profiles** – use new checkbox to require text input before disruptive action

  ![User Properties](image)

  - **Timeout Values**
    - Session timeout minutes: 0
    - Verify timeout minutes: 15
    - Idle timeout minutes: 0
    - Minimum time in minutes between password changes: 0

  - **Invalid Login Attempt Values**
    - Maximum failed attempts before disable delay: 3
    - Disable delay in minutes: 1

  - **Inactivity Values**
    - Disable for inactivity in days: 0
    - Never disable for inactivity

  - **Disruptive Confirmations**
    - Require password for disruptive actions
    - Require text input for disruptive actions
    - Allow remote access via the web

  ![User Properties](image)
Load (IPL) for Alternate Subchannel Set – 2.11.1

- Today Load (IPL) devices must be in subchannel set 0 – this restriction is being removed.
- The ability to Load (IPL) from an alternate subchannel set is now supported.
- Enables customers to utilize the additional device addressability we have provided with less complexity involved.
- The Load Address value was expanded to 5 hex digits – the highorder (left most digit) represents the subchannel set and is restricted to 0, 1 or 2.
  - If 4 digit address used, subchannel set is defaulted to 0.
- Impacted tasks included: Load, Customize/Delete Activation Profiles (Image and Load profiles), and HMC APIs (SNMP and CIM).
Load (IPL) for Alternate Subchannel Set (cont.)

<table>
<thead>
<tr>
<th>Profile name</th>
<th>Description</th>
<th>Load type</th>
<th>Load address</th>
<th>Load parameter</th>
<th>Time-out value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFAULTLOAD</td>
<td>This is the default Load profile: Normal</td>
<td>10D00</td>
<td>60 to 600 seconds</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
View PMV Records – 2.11.1

- The new **View PMV Records** task is used to obtain Problem Management Viewable (PMV) records issued to the IBM Service Support System (Retain) for the Hardware Management Console or selected servers (CPCs).

- These problems are typically sent to the IBM Service Support System where errors are not recorded by the console. A PMV record is initially created from the **Report a Problem** task via a new option.

- The customer is able to view and edit the PMV records on the console and have the ability for an interactive dialog with an IBM service representative.
View PMV Records (cont.)

- New option on **Report a Problem** task
View PMV Records (cont.)

- Retrieval of records from the IBM Service Support System

<table>
<thead>
<tr>
<th>Select</th>
<th>PMV</th>
<th>Machine</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>28463</td>
<td>2817/M15-0000000012345</td>
</tr>
<tr>
<td></td>
<td>30704</td>
<td>2817/M15-0000000012345</td>
</tr>
<tr>
<td></td>
<td>30709</td>
<td>2817/M15-0000000012345</td>
</tr>
<tr>
<td></td>
<td>30710</td>
<td>2817/M15-0000000012345</td>
</tr>
<tr>
<td></td>
<td>30749</td>
<td>2817/M15-0000000012345</td>
</tr>
<tr>
<td></td>
<td>30764</td>
<td>2817/M15-0000000012345</td>
</tr>
<tr>
<td></td>
<td>30778</td>
<td>2817/M15-0000000012345</td>
</tr>
<tr>
<td></td>
<td>30780</td>
<td>2817/M15-0000000012345</td>
</tr>
</tbody>
</table>

**Total:** 8
View PMV Records (cont.)

- Detailed view of one record
2048 bit Network Certificates – 2.11.1

- HMC 2.11.0 and prior use 1024 bit network certificates.

- HMC 2.11.1 will use 2048 bit certificates when
  - new certificates are **Created**
  - and then **Applied**
  - Otherwise, existing certificates carried forward on upgrade to 2.11.1 remain at 1024 bit.
Application Enhancements

- New Task Group
  - A new task group ("Monitor") was created to hold "monitoring" related tasks. Some existing tasks (like Customize Activity Profiles) have been moved to this group plus new tasks are being added. Added to both HMC and SE.
Application Enhancements

- **Environmental Efficiency Statistics Task**
  - Part of a new “Monitor” task group
  - Today the Active Energy Manager (AEM) plugin for the IBM Director includes the ability to show historical power consumption and thermal information. Customers have requested similar capability on the HMC. This task will provide similar data along with a historical summary of processor and channel utilization.
  - The data will be presented in table form, graphical (“histogram”) form.
    - Durations of one to seven days
    - The data can also be exported to a Comma Separated Value (CSV) file so that it can be imported into customer tools like Excel or Lotus 1-2-3.
  - The New Task is only usable with z196 and newer CPCs
  - Data is kept on the SE and should be large enough to store at least one to two years worth of data.
  - The maximum time period that can be shown at one time is one week; however the user can go forward and backward
Application Enhancements

- Environmental Efficiency Statistics Task – Main Panel
Application Enhancements

- **Environmental Efficiency Statistics Task**
  - Data can be exported to a file - only available when a user is connected to the HMC remotely via a web browser.
Application Enhancements

- Environmental Efficiency Statistics Task
  - Resulting CSV file
Application Enhancements

- **SAD (System Activity Display) Re-Engineering**
  - In HMC 2.11.0, a new “Monitors Dashboard” task was added to the Monitor task group.
    - It provides a tree-based view of resources in the IBM System z
    - Allows a user to view aggregated activity when looking at large configurations
    - Also allows for more detail for objects with smaller scope
    - Supports new graphical ways of displaying data such as history charts
  - Pre HMC 2.11.0 ‘Classic SAD’ accessible via ‘Open Activity’ selection on “Monitors Dashboard” panel.
Application Enhancements

- SAD Re-Engineering
Application Enhancements

- SAD Re-Engineering
Application Enhancements

- SAD Re-Engineering - Histogram

The data available to display is:
- Processor utilization (%)
- Channel utilization (%),
- Power consumption (watts/BTUs),
- Input Air Temperature (C/F).

You can display the data in the following increments:
- 15 second increments for 1 hour
- 1 minute increments for 4 hours
- 5 minute increments for 12 hours
- 10 minute increments for 1 day
- 15 minute increments for 2 days
- 1 hour increments for 10 days
App. Enhancements: Security Event Notification

- Email notification of security events
  - Monitor System Events task now supports creating new event monitors for security logs
  - Any number of users can get an email when a matching security log occurs
App. Enhancements: Security Event Notification

- Configuring a security event monitor

![Event Monitor Editor](image)
App. Enhancements: Audit reporting capabilities

- Provide scheduled and manual methods to obtain audit reports which include:
  - All user related data (user ids, user settings, roles, password rules, LDAP servers, automatic logon, etc.)
  - Configuration details (remote access, automation parameters, data replication, network settings, etc.)
  - Operational data (custom group definitions, associated activation profile settings, managed resources)
  - SSL certificate information

- The offloading can be manually initiated via the new Audit & Log Management task or scheduled via the Scheduled Operations task.
App. Enhancements: Audit reporting capabilities

- Provide scheduled and manual methods to obtain audit reports
- Auditable types of information broken in to 3 categories

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Logs</th>
<th>User Profiles</th>
</tr>
</thead>
<tbody>
<tr>
<td>API settings</td>
<td>Console events</td>
<td>Default user settings</td>
</tr>
<tr>
<td>Certificate management</td>
<td>Security log</td>
<td>LDAP server definitions</td>
</tr>
<tr>
<td>Console services</td>
<td>Audit log</td>
<td>Password profiles</td>
</tr>
<tr>
<td>Data replication</td>
<td>Service history</td>
<td>User roles</td>
</tr>
<tr>
<td>Defined CPCs</td>
<td>Tasks performed log</td>
<td>Users</td>
</tr>
<tr>
<td>Domain security</td>
<td></td>
<td>User templates</td>
</tr>
<tr>
<td>Grouping</td>
<td></td>
<td>User patterns</td>
</tr>
<tr>
<td>Monitor system events</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object locking</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Product engineering access</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Welcome text</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Human consumable (HTML) and program consumable (XML) formats available

Entire categories or individual types of data can be selected for inclusion
App. Enhancements: Example Audit Report

Report contains the up to date configuration data for the selected types of data.

Report can be saved remotely using the normal browser “Save as…” or locally to removable media.
App. Enhancements: Offloading of security and event logs

- Provide scheduled and manual methods to offload which include:
  - Security related events (log on/off, configuration changes, disruptive actions, etc.)
  - System events (scheduled operations definition, time sync, retrieval of Licensed Internal Code (firmware) fixes, etc.)
  - Recent task history including task, targets and user
  - Service history log

- The offloading can be manually initiated via the new Audit & Log Management task or scheduled via the Scheduled Operations task.

- The existing Format Security Logs to DVD-RAM task is redundant with these enhancements and was removed from the HMC.

Event based data can be limited to a specific time period.
**App. Enhancements: Log Data Display/Save**

<table>
<thead>
<tr>
<th>Date</th>
<th>Console Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>June 1, 2010</td>
<td>User sysprog of session 14 has switched from user interface &quot;Classic Style&quot; to &quot;Tree Style&quot;.</td>
</tr>
<tr>
<td>3:45:23 PM EDT</td>
<td></td>
</tr>
<tr>
<td>June 1, 2010</td>
<td>User sysprog of session 14 is using user interface &quot;Classic Style&quot;.</td>
</tr>
<tr>
<td>3:45:05 PM EDT</td>
<td></td>
</tr>
<tr>
<td>June 1, 2010</td>
<td>User sysprog has logged on from location czsmith.endicott.ibm.com [9.60.75.166] to session id 14. The user's maximum role is &quot;System Programmer Tasks&quot;.</td>
</tr>
<tr>
<td>3:45:05 PM EDT</td>
<td></td>
</tr>
<tr>
<td>June 1, 2010</td>
<td>User pedebug of session 13 is using user interface &quot;Classic Style&quot;.</td>
</tr>
<tr>
<td>3:41:16 PM EDT</td>
<td></td>
</tr>
<tr>
<td>June 1, 2010</td>
<td>User pedebug has logged on from location bdvalent-009060074164.endicott.ibm.com [9.60.74.164] to session id 13. The user's maximum role is &quot;Product Engineering Tasks&quot;.</td>
</tr>
<tr>
<td>3:41:16 PM EDT</td>
<td></td>
</tr>
<tr>
<td>June 1, 2010</td>
<td>User sysprog has logged off from session id 12 for the reason: The user logged off.</td>
</tr>
<tr>
<td>3:41:16 PM EDT</td>
<td></td>
</tr>
</tbody>
</table>
App. Enhancements: Scheduled generation of reports

New scheduled operation for generating audit reports
App. Enhancements: Scheduled Audit Report Generation

Scheduled Event based data limiting uses days rather than a time period.

Generated report is offloaded via FTP.
Application Enhancements

- Change LPAR Controls – Export to CSV File
  - The Change LPAR Controls task added the ability to export the Change LPAR Controls table data to a CSV (Comma Separated Value) file which can be used for spreadsheet programs like Excel.

  - This support adds a new menu item to the panel and is only available when a user is connected to the HMC remotely via a web browser.
**Application Enhancements**

- **Change LPAR Controls – Export to CSV File**

![CSV Export Functionality]

---

**CSV Export Functionality**

The image displays a table with various fields such as `Logical Partition`, `Active`, `Defined Capacity`, `WLM`, `Current Weight`, `Initial Weight`, `Min Weight`, `Max Weight`, `Current Capping`, `Initial Capping`, `Number of Dedicated Processors`, and `Number of Not dedicated Processors`. The table is used to manage and export configuration data for logical partitions. A new export pushbutton has been added to facilitate this process.
Application Enhancements

- Change LPAR Controls – Export to CSV File
  - Ability to export all or some of the data
Application Enhancements

- Change LPAR Controls Scheduled Operation
  - The following enhancements were made to the existing Change LPAR Controls scheduled operation support:
    - Allow the partition capping value to be specified
    - Allow viewing of Details about an existing Change LPAR Controls schedule operation on HMC.
Application Enhancements

- Change LPAR Controls Scheduled Operation

To create a Change LPAR Weights operation, select each partition and processor type to be included and input the desired weight and capping values.

Ability to modify capping
Application Enhancements

- **ETR Function Removal, Pulse per Second Diagnostic Support, Thresholds**

  - z196 relies solely on STP for time synchronization. It contains two FSP/STP cards which do not have a fiber optic connector to attach to a Sysplex Timer, but continue to provide support of a Pulse per Second (PPS) port.

  - System (Sysplex) Time task for a z196 target:
    - Only displays if STP is enabled
    - No ETR Configuration and ETR Status tabs
    - Allows an ETR ID to be entered on the STP Configuration tab to support participation in a Mixed CTN (Coordinated Timing Network)
    - Add NTP Thresholds capability
      - Suppresses Hardware Messages for
        - Stratum Level changes (due to polling NTP server)
        - Source ID missing for a limited time (i.e., GPS source blocked on a regular basis due to known reason)
Application Enhancements

- **ETR Function Removal, NTP Thresholds**

![IBM System z Hardware Management Console (HMC) 2.11.0](image)

**NEW NTP THRESHOLDS PUSHBUTTON**

**ETR TABS REMOVED**
Application Enhancements: User Templates and Patterns

- **User template**
  - Defines all the same characteristics that would normally be defined for a user
  - Restricted to LDAP authentication

- **User pattern**
  - Defines the pattern to be used to try and match “unknown” user ids with a template
  - Defines a default template to be used for matching user ids
  - Defines the retention time (in days) for modified user setting information
  - Optionally defines LDAP attributes used to determine:
    - User template to be used
    - “Domains” where the pattern is valid

- **Note:** LDAP server used for authentication can be different from the one used to specify the template and domain names
App. Enhancements: User Templates task

Selected the template to be modified, removed, etc.

Drop down menu to choose the action to be performed
App. Enhancements: User Templates

- Restricted to LDAP authentication; no password defined
- Defines which roles a dynamic user based on this template will have
- Additional user properties for user template is the same as for real users
App. Enhancements: User Patterns task

Selected the pattern to be modified, removed, etc.

Drop down menu to choose the action to be performed
App. Enhancements: User Patterns

Patterns allow for 2 different types of expressions

Default template to use if template not specified via LDAP

Number of days user settings data for dynamic users is retained

Optional LDAP attributes used to determine template and valid domains
User Interface

- **User Interface Enhancements**
  - Miscellaneous User Interface enhancements were made in HMC 2.11.0:
    - Tree Style User Interface Enhancements
      - Ability to right-mouse click on object name field to launch context menus

  - What’s New Wizard
    - A simple wizard which describes new features available on the HMC for each release

  - Internet Explorer 8.0
    - Support for displaying the HMC on a remote console using the IE 8.0 browser
    - The following is the complete list of supported browsers
      - IE 6.0 or later
      - IE 7.0 or later
      - IE 8.0
      - IE 9.0 (2.11.1)
      - Firefox 3.5
      - Firefox 3.6
      - Firefox 4.0 (2.11.1)
User Interface

- User Interface Enhancements
User Interface

- User Interface Enhancements – What’s New Wizard
User Interface

- **Classic UI and User Settings Task Improvements**
  - The User Settings and Console Default User Settings console actions were both updated with a new ‘Classic Style’ tab. This new tab allows users to change the look of the Classic UI.
  - There are three choices for laying out the tasks in the Console Actions View:
    - **Classic**: Display the console tasks and task groups just like they currently display. This is the default.
    - **List**: Display all the console tasks in a flat list.
    - **Groups**: The Console Actions View displays groups and a couple of tasks such as Logoff, Shutdown and Users and Tasks. All the console tasks are contained in one or more console task groups. The new console groups are:
      - Security
      - Configuration
      - Management
      - Configuration
      - Logs
      - Internal Code
      - Debug (PEMODE only)
User Interface

- Classic UI and User Settings Task Improvements
  - The user is able to hide one or more of the three panes in the Classic UI. (Task, Views, Task and Work)
  - The context menu in the Classic UI has changed:
    - All the choices in the Classic Style User Settings tab were added.
    - When viewing the Console Actions in Groups view the context menu contains a new selection for navigating up the tree.
    - Right clicking on a console task group, when viewing the Console Actions in Groups view, causes all the child tasks and task groups to display as does Open to open the selected group.
  - When a user resizes one of the panes by dragging the horizontal or vertical separators then new sizes of the panels are persisted. When that user logs back on the pane sizes are restored.
User Interface

- **Classic UI and User Settings Task Improvements**
User Interface

- **Flexible Controls per User on SE**
  - In z10 the Customize User Controls task is available on the HMC and is used to define and customize user roles.
  
  - In z196 the Customize User Controls task was made available on the SE.
User Interface

- Flexible Controls per User on SE

CUSTOMIZE USER CONTROLS NOW AVAILABLE ON THE SE
User Interface

- **View Only User IDs/Access for HMC/SE**
  - The HMC and SE User ID support added the ability to create users who have View Only access to select tasks.
  - The new View Only tasks are simply the existing tasks with minor modifications to their GUI controls which prevent any actions from being taken. The following subset is the first to support a View Only user ID.
    - Hardware Messages
    - Operating System Messages
    - Customize/Delete Activation Profiles
    - Advanced Facilities
    - Configure On/Off
  - To support View Only user IDs:
    - When adding tasks into a new Task Role the option of adding the View Only version of that task is provided.
    - The Access Administrator can then specify these Task Roles to create View Only user IDs if desired.
User Interface

- View Only User IDs/Access for HMC/SE

CLICK-YES

VIEW ONLY VERSION OF HARDWARE MESSAGES WAS ADDED TO THIS NEW TASK ROLE
User Interface

- Additional Control over Toggle Lock and Details Tasks
  - In z10, all Task Roles contain the Toggle Lock task and the Details tasks for the various managed objects.
    - They are not part of a Task Group.
    - They are not shown in the GUI for the Task Role customization.
    - These tasks get copied/added under the covers to any Task Roles that are created.
  
  - In HMC 2.11.0, the GUI shows these tasks (Toggle Lock and Details) which gives the administrator the ability to create Task Roles that do not have them, thus providing a way for the Toggle Lock and Details task to be removed for certain users.
User Interface

- Additional Control over Toggle Lock and Details Tasks

TOGGLE LOCK AND DETAILS APPEAR IN AVAILABLE TASK LIST
Configuration and Service

- **Third Subchannel Set**
  - A new subchannel set of 64K-1 devices was added to the existing two subchannel sets.
  - The following SE tasks contain panels which contains a subchannel set value and now supports values of 0, 1 and 2:
    - The Input/Output (I/O) Configuration task
      - View -> Dynamic Information
      - View -> Channel Path Configuration -> Device Information
    - The Channel Problem Determination task
      - Analyze subchannel data
      - Analyze control unit header
      - Paths to a device
    - The Channel Problem Determination task
      - Analyze serial link status (FCP Channel only)
      - Fabric login status
    - The NPIV Configuration task
      - Display all NPIV port names that are currently assigned to FCP subchannels.
Configuration and Service

- **Increased Number of Processors**
  - In z196 2817, the physical number of processors was increased.
  - The LPAR mode limits have also changed. The corresponding HMC/SE panels were updated to support these new limits.

<table>
<thead>
<tr>
<th></th>
<th>Z10 2097</th>
<th>Z196 2817</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical PUs</td>
<td>80</td>
<td>96</td>
</tr>
<tr>
<td>Total Physical LICCC Processors per System (CPs, zIIPs, zAAPs, IFLs, ICFs, not SAPs)</td>
<td>64</td>
<td>80</td>
</tr>
<tr>
<td>Logical Processors per LPAR</td>
<td>64</td>
<td>80</td>
</tr>
</tbody>
</table>
Configuration and Service

- Broadband RSF/Media Only Firmware Component Updates

- Firmware Updates on System z can be obtained via
  - RSF (Remote Support Facility) IBM Support Center using a
    - Broadband connection or a
    - Modem connection

- Media

- Firmware for zBX components has a tendency to be much larger than current System z FW

- z196 will limit some FW components such they can only be updated via Broadband RSF or Media, not Modem RSF
  - Even in some of those cases, if the size of the FW update is too large, it may be decided to not even put fixes into RSF (RETAIN) and would only be available via media.

- Service team has been working with customers to migrate to Broadband RSF
  - Security concerns of using Broadband versus modem have been addressed.
  - Available from IBM Resource Link: Library->z196>Technical Notes
    - System z Hardware Management Console Broadband Remote Support Facility
Miscellaneous

- Allow setting Acceptable Status for Multiple Objects
  - In z10, setting up acceptable status on a new install requires the user to set the status one object at a time.

  - In HMC 2.11.0, a new field, “Save as default”, was added to each Acceptable Status tab which allows the user to change the acceptable status for all of the currently defined objects of that type.

  - This change will be applied to all object types that currently provide the ability to monitor their status.

  - A warning message is issued before the acceptable status data is actually changed.
Miscellaneous

- Allow setting Acceptable Status for Multiple Objects
**Miscellaneous**

- **New Removable Writeable Media to Replace HMC DVD-RAM**
  - A new removable writeable media is being introduced in HMC 2.11.0 as an alternate to the HMC DVD-RAM.
    - Qualified DVD-RAM media has gone End Of Life.
    - The new media selected is the USB Flash Memory Drive (UFD).
  - Initially, the HMC 2.11.0 will ship with both a DVD-RAM drive as well as a UFD, but over time the DVD-RAM drive will be phased out.
  - All tasks on a HMC 2.11.0 as well as any SEs that can be managed by a HMC 2.11.0
    - previously supported the DVD-RAM/migrated to now support the UFD
  - The UFD is the first media device for which there can be more than one present in the console
    - This is due to the fact that the Backup task requires a UFD in the console.
    - Non-Backup tasks that access a UFD are now aware that more than one UFD can be present in the console and ensure the correct one is accessed.
    - When Multiple UFDs are plugged,
      - One should be the Backup UFD
      - All nonBackup Critical Data tasks (except Format Media) will ignore the Backup UFD.
Miscellaneous

- **Power Saving Mode**
  - The power saving feature is built upon an existing mechanism for cycle and voltage steering. This mode reduces processor cycle time for all System z processors in the system. Memory and IO cycle times are not affected.

  - In z196 the following support was added:
    - HMC/SE User Interface to enable/disable power saving mode (i.e. new Set Power Saving task)
    - Indication on HMC/SE if power saving mode is active.
    - SE-based scheduled operation to enable/disable power saving mode
    - Reset Profile and Power-on-Reset updates to allow Power Saving mode to be specified.
      - The two options are:
        - Custom Energy Management - use values specified on the new **Set Power Saving** task
        - Emergency High Performance – all objects are placed into High Performance model
Miscellaneous

- Power Saving Mode

For zCPC, limit of one transition to Low Power per day
- Low to High
- High to Low
- High to Low to High

- Low to High to Low

Reason
- Based on hardware RAS limits
- Similar concept of limits on flash memory writes
Miscellaneous

- **Power Saving Mode**

![Power Saving Mode Options](image)
Thank you for your time and consideration....

Brian Valentine
HMC/SE Team

Contact for any Questions:
- Brian Valentine, (607) 429-4382, bdvalent@us.ibm.com
Additional Miscellaneous HMC 2.11.0 Enhancements

- CFCC Diagnostics  
  Page: 76 – 78
- 3-D Repair and Verify  
  Page: 79 – 82
- Service User Task for RSF Diagnostics  
  Page: 83 – 84
- Power on Reset Support of Auto I/O Interface Reset  
  Page: 85 – 86
- Consistent Sorting for Operating System Messages  
  Page: 87 – 88
- Controlling Group Capacity with HMC SNMP API  
  Page: 89
- Image Activation Profile Validation Override  
  Page: 90 – 93
- Remove Support for Dynamic ICF Expansion Option  
  Page: 94
- Remove Support for Crypto Express2  
  Page: 95 – 96
Application Enhancements

- **CFCC Diagnostics**
  - Improvements were made to first-failure-data-capture support for diagnosing Coupling Facility Control Code related problems
  - A maximum of 10 new CFCC Diagnostic dumps will be stored on the SE. Each dump is expected to be 128 MB.
    - CFCC Diagnostic dumps are internally triggered based on detection of an error situation.
    - CF Dumps (max of 2) are triggered manually the Dump LPAR Data task.
  - The Delete LPAR Dump Data task was updated to display and allow manual deletion of the new CFCC Diagnostic dumps.
  - The Transmit Service Data task was enhanced to process the new CFCC Diagnostic dumps. A new panel selection was added in order to differentiate the new CFCC Diagnostic dumps from the existing CF dump.
Application Enhancements

- CFCC Diagnostics

![Image of POSE0010: Delete LPAR Dump Data window]

Delete Logical Partition Dump Data Confirmation - POSE0010

You selected to delete logical partition dump data from the hard disk.

Note: The following logical partition data dumps exist on the hard disk. Select one or more dumps to delete.

<table>
<thead>
<tr>
<th>Select</th>
<th>Dump Type</th>
<th>Partition</th>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Logical Partition</td>
<td>12/01/09</td>
<td>09:51:40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Logical Partition</td>
<td>11/05/09</td>
<td>11:21:40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coupling Facility LP01</td>
<td>01/06/10</td>
<td>09:30:02</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coupling Facility LP03</td>
<td>11/16/09</td>
<td>13:06:14</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:26:33</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:16:46</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:17:47</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:18:51</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:19:50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:20:54</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:22:02</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:23:10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CF Diagnostic LP03</td>
<td>11/16/09</td>
<td>09:25:26</td>
<td></td>
</tr>
</tbody>
</table>

Attention: This procedure will permanently remove the dump data from the hard disk.
Application Enhancements

- CFCC Diagnostics

NEW SELECTION FOR ADDITIONAL CFCC DUMP DATA
Configuration and Service

- **3-D Repair and Verify**
  - This change replaced the static location graphics currently used by the Repair/Verify task for FRU location with an interactive 3-Dimensional viewer.
  - It uses the actual system configuration to build the model for a more accurate representation of the system for the SSR (CE).
  - It is possible to rotate and zoom the model, and to show the location of the FRU that will be replaced.
  - In addition it also shows the locations of new parts that are going to be added.
Configuration and Service

- 3-D Repair and Verify
Configuration and Service

- 3-D Repair and Verify
Configuration and Service

- 3-D Repair and Verify
Configuration and Service

- **Service User Task for RSF Diagnostics**
  - A new scheduled operation "Perform RSF Diagnostic Requests" was made available to IBM Service and Product Engineers on the HMC.
  - This task provides the ability to stress the transmission of data to and from IBM support (without storing data in RETAIN) and optionally create tcpdump traces for use by the PE team.
  - The following panel shows the options available when creating the new scheduled operation.
Configuration and Service

- PE/CE Task for RSF Diagnostics
Miscellaneous

- **Power on Reset Support of Automatic I/O Interface Reset**
  - Consistency was improved between the Power on Reset panel and Reset profile.
    - In z10, the Automatic I/O Interface Reset option is available on the Options tab of the Reset profile but is not available on the Options tab of the Power on Reset panel.
    - In z196, the Power on Reset task was updated to include the Automatic I/O Interface Reset option on the Options tab.
Miscellaneous

- Power on Reset Support of Automatic I/O Interface Reset

AUTOMATIC I/O INTERFACE RESET NOW AVAILABLE
Miscellaneous

- **Consistent Sorting for Operating System Messages**
  - In the pre z9 HMC/SE, the Operating System Messages Task arranged the CPC:LPAR name tabs in ascending alphabetical order.
  
  - In the z9 and z10 HMC/SE, this fixed sort order was lost, and the tabs were arranged in a random order.
  
  - In HMC 2.11.0, the ascending alphabetical order sort order in the Operating System Messages Task was restored.
Miscellaneous

- Consistent Sorting for Operating System Messages
### Miscellaneous

- **Controlling Group Capacity with HMC SNMP API**
  - The Change LPAR Group Controls task provides the ability to modify the group members and group capacity setting. These updates can be applied dynamically to the running system or saved to the Group and corresponding Image profiles.

  - In z10, the SNMP API provides support for updating the Group Profile capacity value but does not allow the group capacity setting to be applied dynamically to the running system.

  - In HMC 2.11.0, the SNMP and CIM APIs are enhanced to allow dynamic changes to both the group members and group capacity setting.
Miscellaneous

- Image Activation Profile Validation Override
  - Background
    - Image profiles validated to conform to maximums of LICCC Permanent and Temporary (On/Off CoD, CBU, CPE)
      - Image Mode (ESA/390, CF, LINUX only, etc.)
      - Initial Processor values (including types)
      - Initial storage
    - Validation occurs
      - at Image Activation Profile save
      - Automatically internally and profile migration will occur for
        - Import Profiles
        - LICCC Update
        - Temporary Record Deletion
          - Replenishing records avoids this profile migration situation
        - New GA code release is applied
          - GA1 to GA2
          - MES Upgrade to new Machine Family (ie., z10 to z196)
Miscellaneous

- **Image Activation Profile Validation Override**
  - New Image Profile control that allows override of validation on Save or Migration conditions
    - Default/Recommended Setting: Validate (checkbox control checked)
    - Careful considerations to turn off validation
      - Preparing Image Profiles prior to LICCC records installed
        - Should check and validate profile once LICCC record updates on complete
      - Loaner engines were given in form of permanent capacity and want to maintain Image profile for future sandbox like control
        - Again, should consider validation when ready to use again
  
  - New Hardware Message that Profiles were internally updated
  
  - Detailed explanation of Profile validation and update rules can be found at IBM Resource Link in Publication “Tech Notes” section
    - **IBM Resource Link:** Library->z196>Technical Notes
      - *System z Activation Profile Update and Processor Rules*
        - Will be updated to include this new validation override control
### Image Activation Profile Validation Override

Ensure that the image profile data conforms to the current maximum LICC configuration.
Miscellaneous

- Image Activation Profile Validation Override

![Image of HMC screen showing activation profile validation override]

A set of activation profiles have been imported. Because of this, one or more profiles have been updated to match the current maximum LICCC configuration or to include new profile parameters.

You can start the View Security Log task to see the list of imported profiles and view the changes.

![Image of HMC screen showing activation profile detailed message]
Miscellaneous

- **Remove Support for Dynamic ICF Expansion Option**
  - The Activation Profile support will be updated to remove support for Dynamic ICF expansion both across ICFs and across pool of shared CPs.
  
  - This update will affect the Processors page of a Coupling facility mode Image Profile. The Logical Processor Assignment section of the Processor page will remove the following selections:
    - Dedicated and not dedicated internal coupling facility processors
    - Dedicated internal coupling facility processors and not dedicated central processors
Miscellaneous

- Remove Support for Dynamic ICF Expansion Options

```
[DYNAMIC ICF EXPANSION OPTIONS REMOVED]
```
Miscellaneous

- **Remove Support for Crypto Express2**
  - z10 EC GA3 supported Crypto Express2 and Crypto Express3.
  - z196 is only supporting Crypto Express3.
  - All references to Crypto Express2 were removed from the SE panels and documentation. The affected tasks include:
    - Cryptographic Configuration
    - Cryptographic Management
    - View Lpar Cryptographic Controls
    - View Licenses - This involves removal of the selection "PCIXCC and CEX2C Readme file"
Additional Materials

- Other SHARE Sessions of Related Interest
- Registering for IBM Resource Link Access
- Notable HMC/SE Publications
Other SHARE Sessions of Related Interest

► August 10\textsuperscript{th}, 8:00 – 9:00 AM
  ● 9738: IBM zBX HMC Hardware and Operational Management

► August 10\textsuperscript{th}, 9:30 – 10:30 AM
  ● 9738: zEnterprise Unified Resource Manager

► August 10\textsuperscript{th}, 11:00 AM – 12:15 PM
  ● 9709: zManager: Platform Performance Management

► August 10\textsuperscript{th}, 3:00 – 4:00 PM
  ● 9635: zEnterprise Unified Resource Manager: What's in it for z/VM?

► August 11\textsuperscript{th}, 8:00 – 9:00 AM
  ● 9711: Unified Resource Manager Hands-On Lab - Part 1 of 2

► August 11\textsuperscript{th}, 9:30 – 10:30 AM
  ● 9818: Unified Resource Manager Hands-On Lab - Part 2 of 2
Registering for IBM Resource Link Access

- To view the documents on the Resource Link Web site, you need to register your IBM Registration ID (IBM ID) and password with Resource Link.

- To register:
  - You need an IBM ID to get access to Resource Link.
    - If you do not have an IBM ID and password, select the "Register for an IBM ID" link in the "Your IBM Registration" menu. Return to the Resource Link sign-in page after you get your IBM ID and password.
    - Note: If you’re an IBM employee, your IBM intranet ID is not an IBM ID.
  - Sign in with your IBM ID and password.
  - Follow the instructions on the subsequent page.
Reference Documentation

- Available from “Books” group of Classic Style UI and the Welcome page of the Tree Style UI (& IBM Resource Link: Library->z196->Publications)
  - IBM SC28-6895: Hardware Management Console Operations Guide (Version 2.11.0)
    - IBM SC28-6905: (Version 2.11.1)
  - IBM SC28-6896: Support Element Operations Guide (Version 2.11.0)
    - IBM SC28-6906: (Version 2.11.1)
  - IBM SB10-7030: Application Programming Interfaces
  - IBM SC28-2605: Capacity on Demand User’s Guide
  - IBM SB10-7154: Common Information Model (CIM) Management Interfaces
  - IBM SB10-7155: PR/SM Planning Guide
  - IBM SA22-1086: System Overview (z196)
  - IBM SA22-1087: System Overview (z114)

- Available from IBM Resource Link: Library->z196->Technical Notes
  - System z Hardware Management Console Security
  - System z Hardware Management Console Broadband Remote Support Facility
  - System z Activation Profile Update and Processor Rules
IBM System z Hardware Management Console (HMC) 2.11.0

Trademarks

The following are trademarks of the International Business Machines Corporation in the United States and/or other countries.

<table>
<thead>
<tr>
<th>Trademark</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPN*</td>
<td>IBM logo*</td>
</tr>
<tr>
<td>CICS*</td>
<td>IMS</td>
</tr>
<tr>
<td>DB2*</td>
<td>Infoprint*</td>
</tr>
<tr>
<td>DB2 Connect</td>
<td>Language Environment*</td>
</tr>
<tr>
<td>e-business logo*</td>
<td>MQSeries*</td>
</tr>
<tr>
<td>Enterprise Storage Server*</td>
<td>Multiprise*</td>
</tr>
<tr>
<td>ESCON*</td>
<td>NetView*</td>
</tr>
<tr>
<td>FICON</td>
<td>On demand business logo</td>
</tr>
<tr>
<td>FICON Express</td>
<td>OS/2*</td>
</tr>
<tr>
<td>GDPS*</td>
<td>OS/390*</td>
</tr>
<tr>
<td>Geographically Dispersed Parallel Sysplex</td>
<td>Parallel Sysplex*</td>
</tr>
<tr>
<td>HiperSockets</td>
<td>POWER</td>
</tr>
<tr>
<td>HyperSwap</td>
<td>PR/SM</td>
</tr>
<tr>
<td>IBM</td>
<td>Processor Resource/Systems Manager</td>
</tr>
<tr>
<td>IBM eServer</td>
<td>pSeries*</td>
</tr>
<tr>
<td>IBM@server</td>
<td>RACF*</td>
</tr>
<tr>
<td></td>
<td>Resource Link</td>
</tr>
<tr>
<td></td>
<td>RMF</td>
</tr>
<tr>
<td></td>
<td>S/390*</td>
</tr>
<tr>
<td></td>
<td>Sysplex Timer*</td>
</tr>
<tr>
<td></td>
<td>TotalStorage*</td>
</tr>
<tr>
<td></td>
<td>VM/ESA*</td>
</tr>
<tr>
<td></td>
<td>VSE/ESA</td>
</tr>
<tr>
<td></td>
<td>VTAM*</td>
</tr>
<tr>
<td></td>
<td>WebSphere*</td>
</tr>
<tr>
<td></td>
<td>z/Architecture</td>
</tr>
<tr>
<td></td>
<td>z/OS*</td>
</tr>
<tr>
<td></td>
<td>z/VM*</td>
</tr>
<tr>
<td></td>
<td>zSeries*</td>
</tr>
<tr>
<td></td>
<td>zSeries Entry License Charge</td>
</tr>
</tbody>
</table>

* Registered trademarks of IBM Corporation

The following are trademarks or registered trademarks of other companies.

Java and all Java-related trademarks and logos are trademarks of Sun Microsystems, Inc., in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation.

Red Hat, the Red Hat "Shadow Man" logo, and all Red Hat-based trademarks and logos are trademarks or registered trademarks of Red Hat, Inc., in the United States and other countries.

SET and Secure Electronic Transaction are trademarks owned by SET Secure Electronic Transaction LLC.

* All other products may be trademarks or registered trademarks of their respective companies.

Notes:

Performance is in Internal Throughput Rate (ITR) ratio based on measurements and projections using standard IBM benchmarks in a controlled environment. The actual throughput that any user will experience will vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the workload processed. Therefore, no assurance can be given that an individual user will achieve throughput improvements equivalent to the performance ratios stated here.

IBM hardware products are manufactured from new parts, or new and serviceable used parts. Regardless, our warranty terms apply.

All customer examples cited or described in this presentation are presented as illustrations of the manner in which some customers have used IBM products and the results they may have achieved. Actual environmental costs and performance characteristics will vary depending on individual customer configurations and conditions.

This publication was produced in the United States. IBM may not offer the products, services or features discussed in this document in other countries, and the information may be subject to change without notice. Consult your local IBM business contact for information on the product or services available in your area.

All statements regarding IBM's future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only. Information about non-IBM products is obtained from the manufacturers of those products or their published announcements. IBM has not tested those products and cannot confirm the performance, compatibility, or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

Prices subject to change without notice. Contact your IBM representative or Business Partner for the most current pricing in your geography.